Organize and Prepare
Photos for Processing

Photoshop Elements may be Photoshop’s
smaller sibling, but it is no second-rate
program. Elements uses the same”proeessing
engine that Photoshop uses to make your work
with photos efficient and effective — it is
simpler and directly geared to phetographers.

Photoshop Elements is a complete program
that allows you to import images, organize
them, and sort the good from the bad as well
as make changes to optimize individual photos.
The order of this book follows a workflow that
you can use to work efficiently in Photoshop
Elements.

In this chapter, you learn what it means to
develop a workflow right from the start. You
can quickly import, sort, and organize your
pictures so that you can find them more easily
in the future. You can customize your
workspace to fit your needs and interests and
help you work more efficiently. You can also set
preferences so that your program works its
best. Do not skip over these seemingly
mundane tasks because they can really help
you speed up your work. However, the best
way to work faster in Photoshop Elements is to
spend some time with it. Once you have
practiced and learned the core controls of the
program, you will find that you can work very
quickly with Photoshop Elements.
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Develop a

WORKFLOW

Workflow has become a real buzzword for
photographers working with their images in the
computer, but it simply describes the process of how
you work with images from start to finish. It is
important that you develop a consistent way of
working on your images that will give you reliable
results.

This book is structured in such a way to show you a

Photoshop Elements workflow that really does work.
Although you can skip around in the book to find

specific tips, the book is ordered to follow this
workflow. As you become familiar with the program,
you might find that you have to adapt some of these
ideas to your specific needs. I encourage you to do
that as long as you are getting the results you expect
from your images. These two pages give a quick
overview of a workflow structure.

® Start the process by getting your
photos into Photoshop Elements
in order to sort, keep, delete, and
organize them. You can process
individual photos without going
into the Organizer module of the
program, but the Organizer helps
you manage your digital photos.

@ Set the tonalities of your photos
first, including blacks, whites, and
midtones, and then adjust color.



® Fix problems in your
photos such as wrong
colors, defects in an
image, sensor dust, and
SO on.

e
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® Consider how you want to share
your photos with others, from
prints to photo books to Web

more.

galleries to e-mail and much

Did You Know?

Photoshop Elements was originally
designed to make Photoshop more
accessible for photographers.
Photoshop was originally developed
to help people work on photos in

the computer, not for photographers.

Photoshop Elements has always had
the photographer as the primary
focus of its development and
enhancement.
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Try This!

Make your image immediately fill
the central work area by pressing
Ctrl+0 (if you press Ctrl+0, you get
a file open dialog box). You can do
this when a photo first comes into
the program edit space or when
you have enlarged a portion of the
photo and need to go back to
seeing all of it.

Did You Know?

Editing photos used to mean
picking the good from the bad.
When Photoshop was developed,
the computer folks decided to call
the changes to the images editing,
so there is confusion about what
editing really is for the
photographer. This book avoids
both usages and specifically
describes the process being used.




IMPORT

your images

In order to work on your images, you must get them
into your computer and recognized by Photoshop
Elements. To use the Organizer in Elements, you have
to tell the program how to deal with your photos. It
needs, in a sense, a map to where your photos are
located. Photoshop Elements can help you import
your photos from memory card to hard drive,
including copying them from the card into a specific
folder and renaming the files as well as recognizing

them by Organizer. Or you can tell Elements to
recognize photographs that are already on your
computer.

When you first open Photoshop Elements, choose the
Organizer button to go into that mode. All importing
is done through the Organizer mode. Once the
Organizer recognizes the images, they show up as
thumbnails on your screen and can then be sorted,
collected into albums, and more in order to make
your pictures very accessible to you.

IMPORTING FROM A DiciTAL CAMERA OR
Memory CARD
@ Click File.

@ Click Get Photos and Videos.

@ Click From Camera or Card
Reader.

The Photo Downloader dialog
box appears.

@ Click the Get Photos From
drop-down menu to select
your camera or card reader.

@ Click Browse to select where you
want the photos to go on your
hard drive.



Navigate to the folder #
you want to use in the

directory tree that

appears.

@O Click Make New Folder
for a new group of
photos.
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@ Name your new folder. &=

@ Click to select or create
subfolders in the new folder, such
as based on dates photos were
shot, or choose no subfolders.

©

Click to rename your photos or
keep the original file name.

®

Click to leave photos on the
memory card so that your camera
can reformat the card properly.

@ Click Get Photos.

The photos will now be imported
to your computer and included in
the Organizer.

Did You Know? Did You Know? Did You Know?

A quality memory card reader is The Automatic Download check Most photographers prefer to put

the fastest and most dependable box in the Photo Downloader images into distinct file folders on

way of downloading images. A dialog box sets up your computer their hard drive instead of all lumped

card reader needs no power, can to automatically download photos  together into the Pictures folder.

be left connected to your based on criteria set in Preferences. Photo Downloader lets you set up

computer, and will not be This can be a problem because it specific folders based on date and

damaged if accidentally knocked to  does not allow you to put photos location, for example, in a folder

the floor. into specific folders for each called Digital Photos on your hard
download, nor can you rename drive to make them easier to find if
photos. the Organizer in Elements ever fails.
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IMPORT

your images

Sometimes there are groups of photos on your
memory card, groups that you do not want to mix
together into a single folder. It can be very helpful to
keep your photos separated by folders so that you
can always find images on your hard drive even
without Photoshop Elements. The program gives you
the option to import only the pictures that you want
from a memory card in an advanced dialog box. This

dialog box is very similar to the Photo Downloader
dialog box, but there are some additional choices you
should know about.

Photoshop Elements also allows you to import images
already on your hard drive. The process is very
similar, but does use a different dialog box. This can
be useful when you have transferred pictures directly
from one computer to another, for example.

ADVANCED IMPORTING FROM A DiGITAL
CAMERA OR MEMORY CARD

@ Repeat steps 1 to 3 from the
previous page to open the Photo
Downloader dialog box.

@ Click Advanced Dialog.
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= o The advanced Photo Downloader

dialog box appears.

@ Click Uncheck All to deselect all
photos.

@ Click the first photo of your
group to import.
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Scroll down to the last Wit
photo in the group. nin

Shift+click that last
photo to select all from
the first one, but no
others.

You can Ctrl+click
isolated photos to
add or remove them
from the group.

Click the check box
under any image to
check all that are

selected (! changes
to @),

Click to open Advanced Options
if not already open.

CONTINUED

A good option to choose is
Import into Alboum (&I changes
to &) if you have albums set up.

Click to open Apply Metadata if
not already open.

Click here to select Basic
Metadata.

Add your name for Creator and
Copyright.

Click Get Photos.

The photos will now be imported
to your computer and included in
the Organizer.

Did You Know?

When the Organizer recognizes
photos, Elements does not move
or change them unless you tell it
to. Photoshop Elements is simply
creating a map to these image
files on your hard drive so that it
can find and organize the photos
as needed.

Chapter 1: Organize and Prepare Photos for Processing

Try This!

Use the light bulb icons ().
Photoshop Elements scatters tips
throughout the program to help

you when you do not

understand a particular control
or option. Click the icon and a
tip offers you information on
how to use the control or option.

Did You Know?

Having your name and copyright
information on a photo helps
people keep track of your
photos. Even if you are not a pro,
having your name in the
metadata means that if you give
your photo files to someone,
such as for an organization’s
brochure, everyone will know
whose photos they are.




SORT

the good pictures from the bad

Traditionally, going through your pictures, finding the
good ones and getting rid of the bad ones, was called
photo editing. However, when computer engineers
developed programs like Photoshop, they decided to
call changing pictures in those programs photo
editing, too, so the term can seem confusing. Still,
you do need to go through your pictures and edit
them based on the original definition of the word.

Photoshop Elements gives you some excellent tools to
do just that. You can compare pictures, look at
pictures in different sizes, and discover which pictures
work well for you and which do not. To save hard
drive space and eliminate clutter there, you should
delete images that really do not satisfy you, thus
reducing the number of pictures you have to go
through to find the really good ones.

1
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SeT Up Your VIEW OF THE PHOTOS

Click and drag the thumbnail
slider to change the sizes of your
photo thumbnails.

Click Full Screen View to see a
photo displayed over the whole
screen.

Ctrl+click photos to select images
that you want to rotate.

Click the appropriate Rotate icon
to rotate the selected photos.

Click the Details check box to
show ratings (M changes to H).

Note: You can also click the View
menu and then View Details to
show ratings.

Click the dots to rate your
photos.

You can use a system such as 1
star for reject, 5 stars for best
photos, and other stars to define
which you like or dislike.



DeLETE PHOTOS You Do
Not WANT #

@ Click rating star 1 at the
upper right of the
thumbnail display.

@ To limit photos to only
those with one star, DIFFICULTY LEVEL
click the drop-down
menu to the right of the R
stars and select only.

©

Select all photos with
Ctrl+A.

Press Delete.

®

The Confirm Deletion from
Catalog dialog box appears.

Check the box for Also delete
selected item(s) from the hard
disk to throw out your rejects
(M changes to H).

Make sure that the box for Also
delete selected item(s) from the
hard disk is unchecked to only
remove photos from Photoshop
Elements view ([ changes to ).

If you feel that you made a
mistake, you can click Cancel and
change the ratings.

Click OK to finish the process.

Click the upper right stars to get
your photos in view again.

Remember! Try This! Did You Know?

You can delete images from To see any image at a large size, You can show file names and other
Photoshop Elements and/or off double-click it. This shows you the  detail by using the View menu.
your computer altogether. Simply photo filling the thumbnail area Click View and then select the
select the image you want to without any other photos. This appropriate menu item to show
remove and press the Delete key. helps you better see details in your  you what you need to see in your
This opens a dialog box that lets photos, such as sharpness or thumbnail display.

you decide if you simply want to exposure problems. Double-click

remove the photo from Photoshop  again to go back to the thumbnail
Elements’ view or remove it off of view.
the hard drive completely.
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CREATE ALBUMS

to group your pictures

Albums are groupings of pictures based on your
needs. You can create albums based on events such
as birthdays, locations such as a recently visited city,
family members, and much more.

Albums give you a way of quickly finding pictures
throughout even a very large collection of images.
They also allow you to group pictures together even if
they were not taken at the same time. For example,
you could set up an album based on a child’s nhame

and then put images that have that child in them into
that album. If you kept doing this over time, you
would have a collection of images of that child from
many different times and places.

Albums do not duplicate photographs. They only
create references to where the pictures are on your
hard drive. For that reason, individual pictures could
be in many albums, which can help you find them
faster in different ways.

@ Ctrl+click photos to select
individual images, or click a
photo and then Shift+click the
last image in a group to select
photos in order.

You can also use Ctrl+A to select
all photos.

@ Click the large green plus sign
under Albums and choose New
Album to add an album.

The Albums section of the task
panel can be opened or closed by
clicking the arrow next to the
word Albums.

The Album Details panel appears.

® You can group albums by using
the Album Group function, but
start with None.

@ Type a name for your album.
(5]

Uncheck Backup/Synchronize
until you have a Photoshop.com
account (B changes to ).

Note: See Chapter 10 for more
about Photoshop.com.

® Your selected photos appear in
the Items box.



@ Click an image and drag
it into the Items box to
add a photo to an
album.

e

@ Click to select an image
in the Items box and
then click the red minus
sign to delete it from
the group.
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Neither adding nor
deleting photos from an
album affects their
position on the hard
drive.

© Click Done.

The new album now appears in
the Albums panel.

© Click the album to select it.

The photos you put in the album
now appear with a small icon
below them to indicate they are
in albums.

@® To see that icon, select Details
(M changes to H).

® You can edit your album by
clicking the Edit icon.

Did You Know?

You can add photos to an album at
any time. Whenever you see a
photo that belongs in an album,
click it and then drag it to the
album. It is automatically put into
the album and will appear there
whenever that album is opened.
Remember you are only creating
references to photos and not
actually moving any.

Try This!

You can immediately put any new
photos just imported into
Photoshop Elements into an
album. Simply select all images in
that new group of photos, add an
album with a name appropriate to
that group, and the photos should
appear in the Items box. If not,
simply select and drag the new
pictures into that Item box.

Smart Albums!

You can create smart albums that
automatically add photos to the
album. You set up criteria from file
names to keywords to camera type
in the New Smart Album dialog
box, which you access by clicking
the Album plus sign (E). Whenever
a photo with those criteria appears
in Photoshop Elements, it is
automatically included in the smart
album.
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USE KEYWORDS

to tag your images

Keywords are words that you add to your photo’s Keywords can be as detailed as you want. You can
metadata (information about the image held in the simply add words to large groups of pictures, which
file). They can be an important way for you to makes this process easier. Or if you want to be able
organize and find your pictures because keywords are to really find specific images, you can add a lot of
searchable. Albums are great for creating large very specific keywords to individual pictures.
groupings of pictures that you can readily access. Regardless of how you use keywords, they are still an
With keywords and the search function in Organizer, important part of Photoshop Elements to understand

you can go to very specific images depending on how and use as needed.
you have used these words for your pictures.

@ Click Keyword Tags to open the
keyword part of the Organize
task panel.

@ You can start with the keywords
that are listed.

@ Click the large green plus sign
under Keyword Tags.

A drop-down menu appears.

® You can choose New Category or
New Sub-Category to create your
own category for keywords.

@ Choose New Keyword Tag to add
a keyword.




EETR CEN e

N Fin %

Flarws 43055 F3

0

Icon.

© 6

The Create Keyword
Tag dialog box appears.

ik

Choose a category.

Type a name for your
keyword tag.

Choose an icon if
desired by clicking Edit
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The Edit Keyword Tag Icon dialog
box appears.

@ Click Import to look for
something to use as an icon.

An Explorer window or Open
dialog box appears.

Q Find a photo that looks
interesting, perhaps from the
same group of images.

Click Open to select this photo
for your icon.

Click OK to use this new icon for
your keywords.

Note: It is not required to have an
icon for every keyword tag.

Try This!

When all of the task panel controls
are open, your interface can get
cluttered and confusing. Click the
little arrows at the left of the panel
category titles to open and close a
category of control, such as
Albums. Simplify the workspace by
closing panel categories you are
not using.
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Important!

Pick keywords that help you find
your photos. Your keywords will be
unique to your type of
photography. Adding keywords
that others use but do not fit your
images will make your searches
confusing. Ask yourself, “What do |
need to find?” in order to create
keywords that work for you and
your needs.

Customize It!

You can add as much or as little
information as you want to keyword
tags. The Keyword Tags dialog box
includes the option to add notes or
a specific address for a location.
These are not requirements, only
options that some photographers
will use frequently, others not at all.
Use what you need and what works
for you.




USE KEYWORDS

to tag your images

Keywords are one of those things that many
photographers put off. The best time to do
keywording is when you first import pictures into
Photoshop Elements. At that time, you remember
more things about your pictures anyway. It is also
easier to add keywords then because all of your
pictures are right in front of you.

It is important to understand that you can add
keyword tags to one picture and only one picture, to

a few pictures, or to hundreds. Keywords allow you to
be very specific, down to putting a specific name on
something that appears only in one picture. They also
allow you to be broader in your approach and put a
single word across a whole group of pictures so that
you can find that group again. Keywords work across
all pictures within Organizer so that you can find
pictures throughout Organizer by simply searching for
keywords.

® A new keyword tag appears in
the category you chose in step 5.

@ Select the photos that need this
keyword.

The selected photos have a blue
frame around them.

® Click and drag the selected
photos onto the tag and they will
gain that tag.

You can click and drag multiple
times, with different groups of
photos, to add more keyword
tags to photos.

® A small keyword tag icon appears
below your photos.

(=)

To put a keyword on specific
photos, click the tag.

®

Drag the tag and drop it on the
photo.

Any new categories used this way
appear as new icons below the
photo.



@ Find specific images
based on your
keyword by clicking
the check box in
front of a specific
keyword tag.

@ Click additional tags . . . et m v 0 o e
to narrow your LV L'-L:_ | _I J"l;l_ l\ |, . UJ/'
search.

@ To show specific items in an
album, click the album before
selecting Keyword Tags.

@ To search for images throughout
your image files, click Show All
first.

@) Type a name in the search box to
show photos related to that
name quickly.

Customize It! Did You Know? Try This!

Take any existing keyword tag and
customize it for your needs. Right-
click any keyword tag to get a
context-sensitive menu. This allows
you to edit your keyword or
keyword category, add a new
keyword to the category, add a
new subcategory, or remove
keywords or categories as needed.

Chapter 1: Organize and Prepare Photos for Processing

Photoshop Elements includes a
special feature that allows you to
find people in your photos for
tagging. This is called Find Faces
for Tagging and is found in the
Keyword Tags category of the task
panel. You will see an icon with a
person and a yellow tag (B3). Click
it and all photos with faces will be
highlighted for you.

You can type a list of keywords
based on common descriptions of
things in your photos. You can
then import this list into Photoshop
Elements by clicking the green plus
sign (E) under Keyword Tags and
then selecting From File. This file
must be an XML file. You can save
a Word file as an XML file for this
purpose.




CHANGE THE ORGANIZER

interface as needed

Photoshop Elements has been designed for
photographers, and its interface reflects that.
However, every photographer has unique needs and
ways of working. You can change the way the
interface for Organizer looks and consequently acts to
customize it for your needs.

The controls for affecting the look of the interface are
in the buttons in the top menu bars, such as Album
Order or thumbnail size icons, and in the View and
Window menus. Do not be afraid to try different looks

for your interface — you can always change back to
the original look by re-clicking the button or menu
item.

However you set up your interface, it should be
something that helps you work more efficiently. Do
not simply use something because it is there or
because someone else uses it. Be sure that it really
does help your work in the program. Working in
Elements should be a fun way of interacting with your
pictures.

@ Click the Display button to
change your display views.

@ Click Folder Location view to
show a directory tree.

@ |n the Folder Location view, you
can click directly on a folder to
find photos.

If Elements is not managing
pictures in a folder, right-click the
folder to add them.

@ Change your thumbnail size with
the thumbnail slider.
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Did You Know?

You can control many features of
Photoshop Elements with
keyboard commands. These allow
you to quickly access controls with
just a couple of keystrokes. These
keystrokes are listed next to the
controls in the menus. For
example, you can turn on and off
the detail display for thumbnails by
using Ctrl+D.

@ Click the small arrow #

next to a right panel
category to expand or
collapse the panel
section.

O Click and drag along an

interface edge to make )
it larger or smaller. DEEICULTVLEVEL

@ Click Window to change what is
seen in the interface.

@ Click Hide Task Pane to give a
large image viewing area; click
Show Task Pane to give the
normal view.

Try This! Did You Know?

The Timeline in Photoshop By default, all thumbnails have a
Elements can help you find photos ~ small white border around them to
by date. This can be turned on in make them show up better. Not
the Windows menu. It works for the  everyone likes this border, but it
entire database, so click the Show can be easily turned off. Go to the
All button at the top left of the View menu and click Show Borders
thumbnails first. Then you can around Thumbnails.

select a specific time, and photos

will appear below from that time.

You can also drag the left and right

sliders to limit the dates to show

images.
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SET PREFERENCES

to make Organizer work for you

You can use Photoshop Elements right out of the box
and get good results. However, the program has
some preferences worth considering that allow you to
fine-tune how Elements works with your computer
and your needs.

Elements has two sets of preferences, one for the
Organizer and one for the Editor. In both cases, they
are found at the bottom of the Edit menu. Many of
the choices can be left at their default settings, but

some can be tweaked to refine how Elements works
for you. Many of the settings are self-explanatory. If
you are not sure of something and want to try it, go
ahead, because all of the settings have a Restore
Default Settings button at the bottom of the dialog
box. Just reopen Preferences and use this button to
go back to the defaults. This section offers some
specific options that are especially worth looking at.

o
(2]
(3]

©@ ® ©O

Click Edit to open the Edit menu.
Click Preferences.

Click General.

The Preferences dialog box
appears.

Adjust Interface Brightness to
make the background lighter or
darker.

Choose the order to show images
by date (@ changes to B).

Select a preferred Date Format
(M changes to B).

You can click any category to
adjust specific preferences.



Reader.

reader.
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@ Choose Camera or Card

© Specify default settings
for downloading. The e e
settings shown are a
good starting point.

*

@ Sselect a default location
for your image files as
they are copied from
your camera or card
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Click Sharing to set up e-mail
with Elements.

Choose your e-mail program.

Check Write E-mail captions to
catalog to record and save
captions (M changes to ).

Click OK to close the Preferences
dialog box.

Did You Know?

You can have images in a separate
location not connected to your
computer and still reference them
in Organizer. Photoshop Elements
keeps a small thumbnail for each
of the images so that you can still
see them in thumbnail view. You
can change the size of these
previews in the Files section of
Preferences.

Try This!

Select photos by standard
computer selection commands.
Ctrl+A selects all photos currently
displayed in the organizer.
Ctrl+clicking photos selects them
one after another. Click one photo,
and then Shift+click farther down;
all photos in between are selected.
You can also deselect a selected
photo by Ctrl+clicking it.

Customize It!

If you use a lot of keywords, you can
customize the way they are sorted in
Preferences, in the section called
Keyword Tags and Albums. You can,
for example, change how the
keywords are sorted, either
alphabetically or manually. You can
also choose how the tag icons are
used, and you can even adjust how
fast or accurate face-tagging is done.
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BACK UP YOUR PICTURES

to protect them

Whenever you read about fires and other disasters
destroying people’s property, you always read about
people wanting to save their photo albums. Photos
are important to us in so many ways, whether they
are memories of children growing up or artistic
visions of a great natural setting.

Digital photos are vulnerable to loss from a hard drive
failure — and hard drives do fail. Plus, without a hard
copy, you have no other record of the images. By
backing them up, you can actually add more security
to your pictures than was even possible with

traditional film. It is very easy to back up your photos
onto accessory hard drives that plug into your
computer. These have come down so much in price
that many photographers back up their pictures on
more than one.

Backup is so important that Adobe has added special
backup features to Photoshop Elements 7, which will
be covered in Chapter 10. You should have some
backup of your own that you can control and access
easily, which is covered here.

An external hard drive is one of
the best ways to back up the
images on your computer’s hard
drive.

BAck Up TO AN EXTERNAL HARD DRIVE

@ Click the Display button in the
top menu bar.

@ Choose Folder Location.

@ Find a folder you want to
duplicate for backup in the
folder tree.
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folder.

backup.

backup.

@ I necessary, scroll down
to reveal the external
hard drive.

@ Click the folder you
want to duplicate.

@ Drag the folder to the
external hard drive.

e
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The folder is saved on —
the external hard drive.

Use BAckuP SOFTWARE

@ With your backup software open,
choose the folder or folders you
want to back up.

@ Click the folder icon to find your
@ Choose the accessory drive for
@ Click the folder icon to select the

location for backup.
@ Click Run Now to start the

Did You Know?

Backup software can make your
backups easier. Once you set up
backup software for specific folders
and a specific accessory drive, the
software remembers those locations.
The next time that you ask it to back
up, it simply compares what is in
those two locations and adds only
what is new.
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Try This!

Small portable hard drives designed
for laptops are more expensive than
other accessory hard drives.
However, they can be handy for
accessing your photographs from
your laptop or other computer. In
addition, you can easily store such a
hard drive in a location separate
from your main computer, giving
you added protection.

Try This!

When you try to move a folder of
pictures on your hard drive to a
new drive, Photoshop Elements
tells you if those pictures are
managed by Organizer or not. If
they are not, and you want them
included in Photoshop Elements,
you can simply right-click the folder
and select Add Unmanaged Files to
Catalog.




